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Unboxing and Setting Up 
Your New Chromebook

Setting up a new Windows or Mac computer can be a daunting 
process. There are all sorts of questions to answer and 
configurations to make. It’s typically a process that takes a half hour 
or more, and no one likes doing it.

Setting up a new Chromebook is different. The unboxing and setup 
process typically takes less than 15 minutes, and there’s really not 
much to it. Read on to learn what you need to do.

In this chapter, you will learn what you need 
to do to start using your new Chromebook.

 ➔ Unboxing Your Chromebook

 ➔ Turning On Your Chromebook—For the Very 

First Time

 ➔ Creating a New Google Account
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Unboxing Your Chromebook
A   typical Chromebook is a simple affair. Even the box itself is simple, small, 
and lightweight and, believe it or not, easy to open.

What do you find when you open the box? Here’s what most manufacturers 
pack inside:

 • The Chromebook itself, wrapped for protection

 • AC adapter and power cable

 • Instruction manual and quick start guide

That’s it. Obviously, there are no software or operating system disks 
because all of that is handled over the Internet. (And, as an added bonus, 
a Chromebook does not come with trial software versions or “crapware” 
preinstalled; you get a very clean desktop on first   boot up.)

Turning On Your Chromebook—For the 
Very First Time

Google   claims that it takes less than a minute to set up a new Chromebook. 
The actual setup time is a bit longer than that, but only because the 
Chromebook goes online to download the latest version of the Chrome OS. 
That pushes the setup time to 10 to 15 minutes, depending on the speed of 
your Internet connection. Still, it’s a relatively fast and painless process, as 
you’ll see.

Charging the Battery
Out of the box,      it’s likely that your Chromebook’s battery is not fully charged. 
For that reason, you need to plug it in to an external power source during initial 
setup, and then leave your Chromebook plugged in for several hours to charge 
the battery.
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Set Up a Chromebook
Before   you use your new 
Chromebook, you need to unbox it, 
plug it in, and set it up.

Google Account
Setup is     easiest if you have 
a working Google Account 
before you first set up your new 
Chromebook. Although you can 
create a new Google Account dur-
ing the setup process, it goes a lot 
faster if you can just enter your 
Google Account username and 
password. You can create a (free) 
Google Account from any web 
browser on any computer; just go 
to accounts.google.com and fol-
low the onscreen instructions.

 1. Remove the Chromebook from its 
box.

 2. Connect the AC adapter to the 
power cable.

 3. Connect the AC adapter to the 
power connector on the back or 
side of the Chromebook.

 4. Plug the   power cable into a 
working power outlet.

1

2
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4

Online.indb   PDF:5Online.indb   PDF:5 6/25/15   10:08 AM6/25/15   10:08 AM



Chapter 20 Unboxing and Setting Up Your New ChromebookPDF:6

 5. Open the Chromebook.

 6. Press the Power button.

 7. When the Welcome window 
appears, select your language 
from the list.

 8. Select your keyboard from the list 
(typically US Keyboard).

 9. Select your (wireless) network 
from the list.

Wireless Connections
Learn more about managing 
Wi-Fi connections in Chapter 5, 
“Working Wirelessly.”

 10. When   the Join Wi-Fi Network 
window appears, enter your 
network password.

Secure Networks
Most home     wireless networks are 
secure networks, which means 
you need to supply the appropri-
ate password to access them. In 
contrast, many public wireless 
networks are open networks, 
which means no password is nec-
essary to gain access.

 11. Click the Connect button to 
return to the Welcome window.

5

6
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10 11
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 12. Click the Continue button.

 13. Read the Chrome OS Terms 
and then click the Accept and 
Continue button.

 14. Chrome now checks for operating 
system updates. This may take 
several minutes. When the update 
is complete, your Chromebook 
will restart. After restarting, your 
Chromebook displays the Sign In 
window. 12

13
14
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 15. If you already   have a Google 
Account, enter your email address 
and password; then click the Sign 
In button. If you do not yet have 
a Google Account, go to the next 
section in this chapter, “Creating 
a New Google Account.” To use 
your computer as a guest without 
signing in, click the Browse as 
Guest link.

 16. When prompted, choose a picture 
to display for your account on the 
sign-in screen and then click OK.

Change Your Picture
You can change your account pic-
ture at any later date. Learn how 
in Chapter 4, “Managing Multiple 
Users.”

 17. Google Chrome launches and 
displays the Howdy screen. Click 
the Take a Tour button to view a 
short walkthrough of your new 
Chromebook’s most important 
features.

 18. Click the X at the top-right corner 
to close this window.

You only need to set up your 
Chromebook once. After you’ve 
completed this initial setup, you go 
directly to the login screen each time 
you start   it up.

15

16
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>>>Go Further
CONNECTING A CHROMEBOX
In addition to    Chromebooks, there are also Chromeboxes—desktop 
computers running the Chrome OS. If you’re the proud owner of a 
Chromebox, you not only have to deal with the initial setup (the same as with 
a Chromebook), but also with connecting the Chromebox to your living room 
TV or home theater system. Fortunately, it’s not that difficult.

The ASUS Chromebox  comes with two different types of video connectors 
on the back of the unit—HDMI  and DisplayPort  . Which connector you use 
depends on what type of connector you have on the back of your TV.

To connect the Chromebox to a normal computer monitor, connect an 
adapter cable from the DisplayPort port to your monitor’s DVI input. To 
connect the Chromebox to your living room TV, use an HDMI cable and the 
Chromebox’s HDMI port.

Naturally, you’ll also need to connect your Chromebox to your home network 
to connect to the Internet. The Chromebox has built-in Wi-Fi if you want to 
connect wirelessly, or you can connect via Ethernet using the Chromebox’s 
back-panel Ethernet connector.

You’ll also need to connect a keyboard and mouse to use the Chromebox. You 
can connect any wired keyboard and mouse via USB, or go with wireless units 
if you like. If you’re connecting wirelessly, connect the input device’s mini-
receiver to one of the Chromebox’s USB connectors and you’re ready    to go.

HDMI
DisplayPort

Online.indb   PDF:9Online.indb   PDF:9 6/25/15   10:08 AM6/25/15   10:08 AM



Chapter 20 Unboxing and Setting Up Your New ChromebookPDF:10

Creating a New Google Account
You must have a Google Account to use your Chromebook. Your Google 
Account serves as your user account in Chrome OS.

Guest Account
Although you can use a Chromebook with a guest account, this type of access 
has limited functionality. Learn more about guest accounts in Chapter 4.

Create a Google Account
A     Google Account is completely 
free, and is necessary not just for 
using your Chromebook, but also 
for accessing any Google applica-
tion, such as Gmail or Google Docs. 
It’s easiest to create your Google 
Account before you first set up your 
Chromebook, although you can also 
create a new account during the 
Chromebook setup process.

 1. Turn on your Chromebook, 
proceed to the sign-in screen, and 
click the Create a Google Account 
link.

1
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 2. The Chrome browser now 
connects to the Web and displays 
the Create Your Google Account 
page. Enter your first and last 
name into the Name boxes.

 3. Enter the name you’d like to use 
as a login into the Choose Your 
Username box.

Availability
If someone else is already using 
your chosen username, Google 
prompts you to try another name.

 4. Enter     your desired password 
(minimum of eight characters) 
into the Create a Password box; 
then reenter it into the Confirm 
Your Password box.

 5. Use the Birthday controls to enter 
the month, day, and year you 
were born.

 6. Pull down the Gender list and 
select Female, Male, or Other.

 7. Enter your mobile phone number 
into the Mobile Phone box. (This 
is optional.)

 8. Enter an existing email address 
into the Your Current Email 
Address box. (This is optional.)

 9. In the Prove You’re Not a Robot 
section, enter the verification text 
into the Type the Text box.

 10. Pull down the Location list and 
select your current country.

 11. Check to agree to Google’s Terms 
of Service and Privacy Policy.

 12. Click the Next Step button.

2 34
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 13. Add a     profile photo if you want. 
(This is optional.) To add your 
photo, click the Add a Photo link 
and select the photo to use.

 14. You also have the opportunity 
to create a Google+ account. 
(Google+ is Google’s Facebook-
like social network.) If you want 
to do this, click Create Your 
Profile and follow the onscreen 
instructions. If not, click the No 
Thanks button.

 15. You’ve now created your account, 
and Google displays your new 
Gmail address. Click the Continue 
to Gmail button to set up your 
Gmail account, or close the 
window to continue using your 
Chromebook.

You will need to log out of the     guest 
account to log back on with your 
new Google Account.

13
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Reading an eBook with the 
Kindle Cloud Reader
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Reading eBooks

If you’re an avid book reader, you’re probably aware that most 
of your favorite books are available in electronic format, or what 
we call eBooks. You can read eBooks on dedicated eBook reader 
devices, such as Amazon’s Kindle, or on your smartphone or tablet.

You can also read eBooks on your Chromebook—which is a great 
way to pass the time when you’re out and about.

Purchasing and Reading eBooks with 
Amazon’s Kindle Cloud Reader

First, a   bit of background about eBooks. eBooks are digital versions 
of print books, optimized for reading on portable devices. Two 
major eBook formats are in use today: Amazon’s Kindle format and 
the nonproprietary ePub format. These formats are incompatible, so 
you’ll need different apps to read books in both formats.

In this chapter, you learn how to read 
your favorite electronic books on your 
Chromebook.

 ➔ Purchasing and Reading eBooks with Amazon’s 
Kindle Cloud Reader

 ➔ Purchasing and Reading eBooks with Google Play 
Books

 ➔ Reading ePub eBooks with Readium

 ➔ Reading PDF Files in Chrome
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Currently, the most popular seller of eBooks is Amazon, the online bookseller. 
Amazon sells both traditional printed books and electronic books in their 
own proprietary format. You can read Amazon’s eBooks on Amazon’s Kindle 
eBook reader devices or on any web-connected device (including your 
Chromebook) with Amazon’s Kindle Cloud Reader service.

Sign In to Kindle Cloud 
Reader
The    easiest way to use Kindle Cloud 
Reader on your Chromebook is by 
first installing the (free) Kindle Cloud 
Reader app. Then it’s a simple matter 
of launching the app to open Kindle 
Cloud Reader in the Chrome browser.

The first time you use Kindle Cloud 
Reader, you need to sign in to your 
Amazon.com account or create an 
account if you don’t already have 
one.

 1. Open the Apps panel.

 2. Click the Kindle Cloud Reader 
icon.

 3. The Chrome browser opens, with 
the Kindle Cloud Reader sign-in 
page displayed. If you don’t yet 
have an Amazon account, click 
Create a New Account and follow 
the onscreen instructions.

 4. If you already have an Amazon 
account, enter your email address 
into the Your E-Mail Address box.

 5. Enter your Amazon.com account 
password into the Your Password 
box.

 6. Click   Sign In.

21
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Purchase eBooks from 
the Kindle Store
The     main page of the Kindle Cloud 
Reader displays eBooks you’ve previ-
ously purchased and downloaded 
from Amazon. You can also purchase 
new books for reading on your 
Chromebook and other devices.

 1. From the Kindle Cloud Reader 
main page, click Kindle Store. 
This takes you to Amazon’s Kindle 
Store website.

 2. To search for a specific book, 
enter that book’s title or author 
into the top-of-screen search box 
and then press Enter.

 3. To browse books by category, 
scroll down the page and click 
a category in the left-hand 
navigation column.

 4. Click the title of the book you 
want to purchase; this displays 
the book’s Amazon page.

1

2

3
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Free Samples
Amazon offers  free samples 
for many of the eBooks it sells. 
Look for the Try It Free box and 
then click the Send Sample Now 
button.

 5. Pull down the Deliver To list and 
select Your Kindle Cloud Reader.

 6. Click Buy Now with 1-Click. The 
book is now purchased and 
delivered electronically to your 
    account.

Read an eBook with 
Kindle Cloud Reader
All the     eBooks you purchase from 
Amazon are automatically stored 
online, in what Amazon calls the 
cloud. You use the Kindle Cloud 
Reader to open any book you’ve pur-
chased and read over the Internet.

 1. From the Kindle Cloud Reader, 
make sure that Cloud is selected.

 2. Click a book cover to begin 
reading that book.

6

5
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 3. To turn the page, press the right-
arrow key on your keyboard or 
click the right side of the screen 
with your mouse.

 4. To return to the previous page, 
press the left-arrow key on your 
keyboard or click the left side of 
the screen with your mouse.

 5. To display options bars at the top 
and bottom of the screen, mouse 
over any part of the current page.

 6. To bookmark the current page for 
future reference, click the Book-
mark icon in the top options bar.

 7. To jump to another location in the 
book, click and drag the slider in 
the bottom options bar.

 8. To return to your eBook library, 
click the Library button in the top 
    options bar.

Change How a Book Is 
Displayed Onscreen in 
Kindle Cloud Reader
One of the      nice things about eBooks is 
that you can easily change how the text 
is displayed onscreen. With Kindle Cloud 
Reader, you can make the text larger or 
smaller, change the page margins, and 
even change the color of the text and the 
page background.

 1. From within the book, mouse over 
the page to display the options 
bars.

 2. Click View Settings in the top 
options bar to display the View 
Settings pane.

8 6 3

7 45
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 3. To make the text larger or smaller 
for easier reading, click a different 
option in the Font Size section.

 4. To change the white space on 
the sides of the screen, click a 
different option in the Margins 
section.

 5. To change the way the text 
appears onscreen, make a 
different selection in the Color 
Mode section. You can select 
from White (black text on a white 
background), Sepia (dark brown 
text on a sepia background), 
or Black (white text on a black 
background).

 6. To force the book to display only 
a single column at a time, go to 
the One Column Only section and 
click On.

 7. Click Apply Settings when      done.

3 4

75 6

Purchasing and Reading eBooks with 
Google Play Books

Amazon’s Kindle format is one of the two major eBook formats, and it’s 
proprietary. That is, you can only read Kindle books on a Kindle eBook reader 
device or via the Kindle app.

The other major eBook format is called ePub , and it’s more universal. 
Although you can’t read ePub books in the Kindle app, you can read them in 
other eBook apps, and on other eBook reader devices.

You can also purchase ePub-format eBooks from a number of online sources, 
one of which is the Google Play store. The books you purchase from Google 
Play are readable with Google’s Play Books app .
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Play Books
The Play Books app should be installed as part of Chrome OS. If it isn’t, you can 
download it for free from Google’s Web Store.

Purchase eBooks from 
the Google Play Store
The      main screen of the Play Books 
app displays eBooks you’ve previ-
ously purchased and downloaded 
from the Google Play Store. You can 
also purchase new books for read-
ing on your Chromebook and other 
devices.

 1. Open the Apps panel.

 2. Click the Play Books icon to open 
the Play Books app in the Chrome 
browser.

 3. All the books you’ve previously 
purchased are listed on the My 
Books Bookshelf page. To shop for 
new books, click the Shop Books 
button.

 4. To search for a specific book or 
author, enter the book’s title or 
author name into the search box 
and then press Enter.

 5. To browse books by genre, click 
the Genres button and then click 
a specific genre.

1
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 6. Click the cover of the book you 
want to purchase.

 7. Many books offer free samples. To 
download a sample, click the Free 
Sample button.

 8. To purchase a book, click the Buy 
button.

 9. When the confirmation box 
appears, select your method of 
payment.

 10. Click the Buy button. The book 
is now added to your Play Books 
     library.

Read an eBook with 
Google Play Books
The books     you purchase from the 
Google Play store can be read from 
the Play Books app in the Chrome 
browser.

 1. Launch the Play Books app and 
make sure that My Books is 
selected.

 2. Click the book you want to read.

6
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 3. To turn to the next page, press 
the right-arrow key on your 
keyboard or click the right-arrow 
icon at the bottom-right corner of 
the screen.

 4. To return to the previous page, 
press the left-arrow key on your 
keyboard or click the left-arrow 
icon.

 5. To bookmark the current page 
for future reference, click the 
Bookmark icon at the top of the 
screen.

 6. To jump to another location in the 
book, click and drag the slider at 
the bottom of the screen.

 7. To return to your Play Books 
library, click the Exit link in the 
top-left corner of the     screen.

Change How a Book Is 
Displayed Onscreen in 
Google Play Books
As with      the Kindle Cloud Reader, you 
can easily personalize your reading 
experience in the Play Books app.

 1. From within the book, click the 
Display Options icon at the top 
of the screen. This displays the 
Display Options panel.

 2. Some books are available with the 
choice of flowing text or scanned 
pages. To change the display, 
click the View control and make a 
selection.

7 5
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 3. To change the typeface used to 
display the book text, click the 
Typeface control and make a 
selection.

 4. To change the number of pages 
displayed onscreen at a time, go 
to the Page Layout section and 
make a selection.

 5. To make the text larger or smaller 
for easier reading, go to the Text 
Size section and click either the – 
or + button.

 6. To change the line spacing, go to 
the Line Height section and make 
a selection.

 7. To change the text justification 
(left aligned or justified), go to 
the Justify section and make a 
selection.

 8. Click the X to close the      panel.

Reading ePub eBooks with Readium
You can download ePub-format eBooks from a number of online stores and 
libraries. To read these books, you need an e-reader app that’s compatible 
with the ePub format.

One of the most popular ePub apps for Chrome is Readium . It installs as a 
Chrome browser extension; you can then use it to open and read ePub files 
stored on your Chromebook, on an attached storage device, or stored online 
in Google Drive.

Finding ePub Books
eBooks in ePub format  are available from numerous sources. The eBooks sold by 
Barnes and Noble online are in ePub format, as are most eBooks sold by other 
non-Amazon retailers. (And, remember, the Google Play store sells books in ePub 
format.) It’s likely that your local library offers eBooks in ePub format, as well.
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Add Books to the 
Readium Library
To use    Readium, you first have to 
install the Readium extension. Just 
go to the Chrome Web Store, click 
Extensions, and search for Readium; 
it’s free. You can then add any 
ePub-format eBooks you have to 
the Readium library.

 1. Open the Apps panel.

 2. Click the Readium icon to open 
the Readium Library page in the 
Chrome browser.

 3. Click Add to Library (+) in the top 
toolbar.

 4. When the Add to Library panel 
appears, click the Choose File 
button in the From Local File 
section.

 5. This opens Chrome’s Files app. 
Navigate to and select the ePub 
file you want.

 6. Click the Open button. This book 
is now added to the Readium 
   library.
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Read an eBook with 
Readium
The Readium app     displays in a tab in 
the Chrome browser. The home page 
displays the Readium library, with all 
the books you’ve added.

 1. From the Readium library page, 
click the book you want to read. 
That book is now displayed in the 
browser window.

 2. To turn the page, press the right-
arrow key on your keyboard or 
click the right side of the screen 
with your mouse.

 3. To return to the previous page, 
press the left-arrow key on your 
keyboard or click the left side of 
the screen with your mouse.

 4. To display the options bar at the 
top of the screen, mouse over any 
part of the current page.

 5. To display the book full screen, 
click the Enter Fullscreen button. 
(Press Esc to return to normal 
browser mode.)

 6. To display the book’s table 
of contents, click the Table of 
Contents button.

 7. To return to your eBook library, 
click the Library     button.
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Change How a Book Is 
Displayed Onscreen in 
Readium
Readium lets      you fully personalize 
the book-reading experience. You 
can change the text size, text and 
background color, and the effect you 
see when turning the page.

 1. From within the book, mouse 
over the page to display the 
options bar.

 2. Click the Settings button to 
display the Settings pane with the 
Settings tab selected.

 3. To make the text larger or smaller 
for easier reading, click and drag 
the Font Size slider.

 4. To change the white space on the 
sides of the screen, click and drag 
the Margins slider.

 5. To change the way the text 
appears onscreen, make a 
different selection in the Text 
and Background Color section. 
You can select from the book’s 
Default setting, Black and White 
(black text on white background), 
Arabian Nights (white text on 
black background), Sands of 
Dune (dark brown text on sepia 
background), Ballard Blues (white 
text on dark blue background), or 
Vancouver Mist (dark blue text on 
gray background).

1 2
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 6. To force the book to display only a 
single column at a time, go to the 
Display Format section and select 
the second option. Select the 
third option to display the text 
in two-column format. Select the 
Auto option to display the text as 
intended by the publisher.

 7. To change the way the book 
pages scroll, go to the Scroll 
Mode section and select Auto, 
Document, or Continuous.

 8. To apply a special effect when the 
page is turned, go to the Page 
Effects section and select from 
Fade, Slide, Swoosh, or Butterfly. 
(Page effects are disabled by 
default.)

 9. Click Save Changes when      done.

6 7

8 9

Reading PDF Files in Chrome
Many      eBooks you find online are also available in Adobe’s PDF format. 
The advantage of PDF files is that they appear exactly as designed by the 
publisher; a PDF file is an exact representation of the original printed book. 
(Kindle- and ePub-format books, on the other hand, can be formatted by the 
reader for easier reading on any given device.)

As such, many readers prefer the PDF format for visually oriented books, such 
as children’s books or four-color “coffee table” titles. For this reason, many 
publishers make their books available in PDF format, as well as Kindle and 
ePub formats.
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Open and Read a PDF 
File
Because Chrome OS      includes a built-
in PDF viewer, reading PDF-format 
eBooks is a snap.

 1. Open the Apps panel.

 2. Click Files to open the Files app.

 3. Navigate to and select the PDF file 
you want to read.

 4. Click the Open button. The file 
now appears in a Chrome browser 
tab.

 5. To scroll through the document, 
use your keyboard’s up- and 
down-arrow controls, or the 
onscreen scroll bar.

 6. To display additional controls, 
mouse over the lower-right corner 
of the page.

 7. To display the document a full 
page at a time, click the Full Page 
button.

 8. To view the document so that 
the width of the page fills up the 
browser window, click the Page 
Width button.

 9. To zoom out of the page, click the 
Zoom Out button.

 10. To zoom in to the page, click the 
Zoom In      button.
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Video Chatting with Google 
Hangouts

If you travel a lot or conduct a lot of remote business meetings, 
you need a way to keep in touch with your friends, family, and 
colleagues. The best way to have a face-to-face conversation when 
you’re not in the same room is to conduct a video call. With your 
Chromebook, you do this over the Web, via Google Hangouts.

Google Hangouts   are real-time video chats you can participate 
in either one-on-one or with a group of people (up to ten). To 
participate in a Hangout, all you need is your Chromebook (with 
its built-in webcam, microphone, and speakers), an Internet 
connection, and a Google Account. (And, if you prefer text chatting, 
you can do that, too!)

In this chapter, you learn how to keep in 
touch with friends, family, and colleagues via 
Google Hangouts.

 ➔ Participating in Video Hangouts

 ➔ Participating in Text Chats
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Participating in Video Hangouts
Google Hangouts    started out as part of the Google Plus social network, but 
it has since become a standalone service. On your Chromebook, you use the 
Hangouts app to initiate and participate in Google Hangouts.

Open a Hangout
Before      you open your first Hangout, 
you’ll need to download the 
Hangouts app. You can find it in 
Google’s Web Store. Just search for 
Hangouts; it’s free.

 1. Open the Apps panel.

 2. Click the Hangouts icon.

 3. This displays a green Hangouts 
(”) icon on the right side of the 
desktop. Click this icon to display 
a new Hangouts panel.

 4. Your most recent Hangouts 
are listed in this panel. Click 
a Hangout to resume the 
conversation.

 5. To start a new Hangout, click the 
search box and enter the Google 
Account name or email address 
of the person you want to talk to. 
(Alternatively, check any of the 
names already listed; these are 
people you’ve previously talked 
with.)

1 2

5 4 3
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 6. The pane changes to a chat pane. 
To initiate a video call, click the 
Video Call (camera) icon. This 
opens a new browser tab and calls 
the person you want to talk to.

 7. When your friend answers the call, 
her picture appears large in the 
Hangout window. Your picture 
appears smaller, at the bottom. 
Start      chatting!

Manage and Exit a 
Hangout
Most     hangouts are simple affairs, 
where you talk one-on-one with 
the other person. You can, however, 
mute the sound or picture during the 
Hangout, as well as employ one or 
more tools that Google supplies.

 1. Mouse over the screen to vdisplay 
the options bar at the top of the 
window, as well as the toolbar 
along the left side.

 2. To mute  your microphone, click 
the Mute Microphone button.

 3. To turn off your Chromebook’s 
camera, click the Turn Camera Off 
button.

 4. To use the tools that Google 
supplies, click the appropriate 
icon along the left side of the 
screen. For example, to capture a 
screenshot of the session, click the 
Capture icon. To add a text-based 
chat to the Hangout, click the Chat 
button.

 5. To exit the     hangout, click the 
Leave Call (telephone) button.

6
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Join an Existing Hangout
You don’t     have to initiate all your 
Hangouts. In many cases, it’s some-
one else who wants to talk, and 
invites you. If you’re online, it’s easy 
to join a Hangout.

Email Invitations
Some users prefer  to email 
invitations to their Hangouts 
in advance, which is a useful 
method to use when scheduling 
a business meeting. When you 
receive an email invitation, you 
can join the Hangout by clicking 
the link in the message.

 1. When another user invites you 
to a Hangout, you see a message 
to that effect on the Chrome 
desktop. Click the message to 
display a chat pane.

 2. Click the Video Call button to 
open the Hangout in a browser     
tab.

Invite Others to an 
Existing Hangout
In addition     to one-on-one video 
chats, you can create group 
Hangouts with more than two peo-
ple participating.

 1. Start a normal Hangout; then 
mouse over the screen to display 
the options bar and click the 
Invite People button. This displays 
the Invite pane.

1

2

1
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 2. Enter the Google Account name 
or email address of the person 
you want to invite into the Send 
Invite box. Enter multiple names if 
you want.

 3. Click the Invite button.

 4. When the other person answers, 
he is automatically added to the 
Hangout. Whomever is talking at 
the moment appears in the main 
window; the other participants 
appear in smaller windows along 
the bottom of the screen.

Invite via Email
You can, if you prefer, set up a 
Hangout in advance and then email 
the link to the participants. Just 
start a Hangout and click the Invite 
People button. When the Invite 
pane appears, copy the link in the 
first box and paste it into your 
email message. When participants 
open the email, they can enter the 
Hangout by clicking      the link.

Quit Google Hangouts
The Google Hangouts app    remains 
open on your desktop until you 
manually close it.

 1. Mouse over the green Hangouts 
icon on the desktop and click 
the X.

 2. When prompted, click the Quit 
button.

3

2
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2
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Participating in Text Chats
Google also     offers the ability to participate in text chats with your friends and 
colleagues. This is part of Google Hangouts.

Create a New Text Chat
The advantage of text chats is that 
you can talk to people who don’t 
have webcams installed on their 
computers. You also don’t have to 
look your best when chatting; there 
are no webcams staring you in the 
face.

 1. Open the Apps panel.

 2. Click the Hangouts icon.

 3. This displays a green Hangouts 
(”) icon on the right side of the 
desktop. Click this icon to display 
a new Hangouts panel.

 4. Your most recent Hangouts 
are listed in this panel. Click 
a Hangout to resume the 
conversation.

 5. To start a new Hangout, click the 
search box and enter the Google 
Account name or email address 
of the person you want to talk to. 
(Alternatively, check any of the 
names already listed; these are 
people you’ve previously talked 
with.)

1 2

3
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 6. The pane changes to a chat pane. 
Enter your first message into the 
box at the bottom of the pane 
and then press Enter.

 7. Your conversation with the other 
person appears in the main chat 
pane. Continue typing to send 
more messages.

 8. To end the chat, click the X at the 
top-right corner of the      chat pane.

87
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Using Microsoft Office 
Online

The   Google Docs suite isn’t the only web-based productivity tool 
you can use on your Chromebook. More and more productivity 
apps are moving from the traditional software world to the world of 
cloud computing—including the venerable Microsoft Office.

Understanding Microsoft Office 
Online

Microsoft Office   has long been the most popular productivity suite 
for both home and office workers. Until recently, the only way to 
use Office was to install the software package on your computer—
which you can’t do on a Chromebook. Fortunately for Chromebook 
users everywhere, Microsoft has released a web-based version of 
Office, and it works great on the Chrome OS.

In this chapter, you learn how to use 
Microsoft Office Online on your Chromebook.

 ➔ Understanding Microsoft Office Online

 ➔ Working with Word Online

 ➔ Working with Excel Online

 ➔ Working with PowerPoint Online

Online.indb   PDF:39Online.indb   PDF:39 6/25/15   10:08 AM6/25/15   10:08 AM



Chapter 23 Using Microsoft Office OnlinePDF:40

Microsoft Office Online, as the web-based suite is called, consists of seven 
applications plus OneDrive , Microsoft’s web-based storage service (similar to 
Google Drive). The applications include the following:

 • Word Online (word processing)

 • Excel Online (spreadsheets)

 • PowerPoint Online (presentations)

 • People (contact management)

 • Calendar (scheduling)

 • Outlook.com (email)

 • OneNote Online (note taking)

Obviously, a web-based version of Office has appeal to the hundreds of 
millions of people who use the traditional Office software. Also appealing 
is the price; Microsoft Office Online is completely free, unlike the more 
expensive software versions.

Note, however,  that the individual apps in Office Online don’t come with 
all the power features of the software versions. In this aspect, Office Online 
resembles Google Docs; average users will find all the features they need, 
whereas power users might need more sophisticated functionality.

That said, Microsoft Office Online is very, very similar in functionality to the 
Google Docs suite. Both suites let you work and store your files online, as well 
as share those files with collaborators via the Internet.

You access  Office Online from within the Chrome browser. Go to www.office.
com and sign in with your Microsoft account. (If you don’t have a Microsoft 
account, click My Account and then click Sign Up for a New Account.) You can 
also download Office Online apps from the Chrome Web Store.
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The main Office Online page displays tiles for all available web-based apps. 
To launch an app, click the app’s tile. From there you can open existing files or 
create new ones.

Microsoft OneDrive
You can also open and edit existing Office Online documents from Microsoft 
OneDrive . Go to www.onedrive.com to view your online files; click a file to open 
it in the corresponding online app.

You can also use Office Online to share documents with friends and 
co-workers. Click the Share button in any app to invite individuals to share 
that particular file; you can choose whether users can edit or only view    a 
given file.

Working with Word Online
If you’re    familiar with the desktop version of Microsoft Word, Word Online will 
look quite familiar. At the top of the screen is the ribbon, which provides all 
the buttons and controls you need to create and edit a document. Different 
tabs on the ribbon display different collections of functions; click a tab, such 
as File, Home, Insert, or View, to access commands associated with that 
particular operation.
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For example, the File tab contains basic file opening and saving operations; 
the Home tab contains most of the editing and formatting functions you use 
on a daily basis; the Insert tab contains commands to add images and tables 
to a document; and the View tab contains commands that enable you to 
change how a document is viewed or displayed.

Beneath the ribbon is the document itself. To enter text, position the cursor 
where you want (in a blank document, it’s in the first line of the document) 
and start typing.

As with Google Docs, you don’t have to manually save your files in Word 
Online. Any changes you make are automatically saved, and the files 
themselves reside in the cloud, in    OneDrive.

Working with Excel Online
Excel Online    looks and feels much like the traditional desktop version of 
Excel. As with Word Online, Excel Online features a ribbon at the top of the 
screen, with different tabs for different functions. The Home tab contains 
basic editing tools; the Insert tab is used to insert charts and tables and such; 
the Data tab is where you sort your data; and so on.

Excel calls its spreadsheets worksheets , and each worksheet can contain 
multiple sheets, accessible via tabs at the bottom of the workspace. As with 
all spreadsheet programs, Excel Online lets you create complex formulas and 
includes a robust set of built-in    functions.

RibbonRibbon tabs Document
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Working with PowerPoint Online
You    use PowerPoint Online to create and give presentations. It isn’t quite 
as functional as the software version of the program, but it’s similar in 
functionality to Google Slides.

RibbonRibbon tabs

WorksheetSheet tabs

RibbonRibbon tabs

Speaker 
notes

Slide sorter Slide editor
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As with the other Office Online apps, you access all necessary functions 
from the ribbon at the top of the screen. Beneath the ribbon, the screen is 
divided into three areas: the slide sorter on the left, the slide editor on the 
right, and the speaker notes at the bottom. You can apply a variety of visually 
interesting themes, as well as slide transitions and animated elements on a 
slide.

Giving a presentation is as easy as clicking the Slide Show button at the 
bottom-right corner of the screen. This displays your presentation full screen; 
use the right-arrow key on your keyboard (or click your touchpad) to move 
from slide    to slide.

>>>Go Further
OFFICE ONLINE VS. GOOGLE DOCS
For   some time, Google Docs was the only viable web-based productivity suite. 
With the advent of Microsoft Office Online, however, you now have a choice. 
Which of these suites should you use?

Because of its time in the market, Google Docs has a large base of satisfied 
users. The individual apps have been greatly enhanced over the years, and 
chances are they’ll do everything you need them to do.

Office Online, on the other hand, is both newer and older. It’s a newer entry 
into the web-based market, but it’s based on the long-established desktop 
program.

If you use Microsoft Office every day at work, then Office Online is a good 
choice. Not only does it sport a familiar interface, it’s fully file compatible with 
the desktop version of the program.

Google Docs is also file compatible with Office, but the interface for each app 
is different. There are no ribbons in Google Docs; you have to use the older 
pull-down menus and toolbars, instead. That may not be a big thing for you, 
or you may find it more productive to stay with the similar interface of the 
Office products. That’s a user choice.
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Although both suites store their files online and claim robust sharing and 
collaboration features, I’ve found that Google Docs is just a little better at the 
whole sharing thing. You can certainly share your Office files online, but it’s 
just a tad easier with Google Docs and Google Drive. That’s probably Google’s 
online experience showing.

Bottom line, you can’t go wrong with either Google Docs or Microsoft Office 
Online. They both offer the necessary features to help you do what you need 
to do, they both let you share your files online, and they both work great on a 
Chromebook. Equally important, they’re both free—so try them both and use 
the one that   works best for you.
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What Chromebook Should 
You Buy?

What’s Not to Like?
Whether    you’re in the market for a tablet or notebook computer, a 
Chromebook certainly sounds like a contender for your purchase 
dollars. But Chromebooks aren’t for everyone; there are some 
limitations in using a Chromebook for your computing and web 
surfing. In particular, consider the following:

 • You need an Internet connection. Because  Chrome OS is a 
web-based operating system, a Chromebook is virtually useless 
if you can’t connect to the Internet. You use the Internet to 
connect to both your applications and documents, so if you 
don’t have an Internet connection, you can’t access anything, 
even your own documents. A dead Internet connection means 
no work, period—and, in areas where Internet connections are 
few or inherently unreliable, this could be a deal breaker. Aside 
from being able to listen to some music that you may have 
stored on the hard drive, when you’re offline, a Chromebook 
really doesn’t do anything.
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Working Offline
Some web-based applications,  such as Google Docs and Gmail, have offline 
modes that let you continue working without an Internet connection. Most 
other apps, however, need to be connected to run. (And, naturally, you need 
an Internet connection to view or listen to streaming media, and to browse the 
Web.)

 • Doesn’t work well with slow connections. Similarly , a low-speed 
Internet connection, of which parts of this country have way too many, 
makes using a Chromebook painful at best and often impossible. 
Web-based apps often require a lot of bandwidth to download, as 
do streaming movies and music. If you’re laboring with a low-speed 
connection, it might take seemingly forever just to change from page 
to page in a document, let alone use a streaming audio or video service. 
In    other words, using a Chromebook isn’t for the slow or “broadband 
impaired.”

 • You can’t use traditional software. Even  though lots of free and low-
cost web-based applications are available, not all the programs you 
currently use have web-based counterparts. Although the number of 
web-based apps is rapidly increasing, and most major apps (including 
Microsoft Office and Adobe Photoshop) have web-based versions, these 
cloud applications sometimes offer less functionality and compatibility 
than their traditional software cousins. And if you like to play games on 
your computer, you’re pretty much limited to what’s available for online 
play. Make sure you can do what you need to do totally over the Web 
before you make the jump to a Chromebook.

 • Is cloud-based data really secure? With   cloud computing, all your data 
is stored on the cloud. That’s all well and good, but how secure is the 
cloud? Can other, unauthorized users gain access to your confidential 
data? These are all important questions, and well worth further exami-
nation. If you’re at all worried about data security or reliability, using 
Chrome OS might not be for you.

And when you’re comparing a Chromebook with a     tablet, consider the 
following issues:

 • It’s heavier than a tablet. Although a Chromebook is a very light 
notebook PC, it’s still a little heavier than a tablet. HP’s 11-inch 
Chromebook comes in at 2.83 pounds, whereas its 14-inch model weighs 

Online.indb   PDF:48Online.indb   PDF:48 6/25/15   10:08 AM6/25/15   10:08 AM



PDF:49What Chromebook Should You Buy?

3.78 pounds, both considerably heavier than the iPad, which weighs just 
1.44 pounds. If weight matters, a tablet may be more appealing.

 • You need someplace to type. This isn’t a big deal, but you can operate 
a tablet while holding it in your hand. Not so much with a Chromebook; 
you either need to sit it in your lap or on a desktop in order to type on 
the keyboard. If ultimate portability is your goal, the tablet wins,    hands 
down.

What Chromebook Should You Buy?
If you’ve   read this far, I’ll assume that you’re still interested in purchasing 
a new Chromebook computer. The next question is a simple one—what 
models are available?

The first generation of Google Chromebooks launched back in 2011. These 
were more expensive units, running anywhere from $349 to $499. As you 
might suspect, that pricing made them less than stellar performers in the 
marketplace.

In mid-2012, Samsung introduced two second-generation Chromebook 
models, priced at $449 and $549. Despite display and keyboard 
improvements, these models were viewed as too expensive and generally 
ignored by consumers.

That all changed in October of 2012, when the third generation of 
Chromebooks hit the market—and were an immediate hit with consumers. 
Not only was Chrome OS itself improved over the initial version, but these 
new Chromebooks—from Acer and Samsung—offered a lot more bang 
for the buck. With pricing starting as low as $199, Chromebooks suddenly 
became a lot more attractive, especially for users looking for a second 
computer-like device for casual use. In fact, these new Chromebooks were 
so popular that they sold out well before Christmas, and the Samsung 
Chromebook was Amazon.com’s best-selling notebook PC of that holiday 
season. (Chromebooks were also Amazon’s bestsellers in the 2013 and 2014 
holiday seasons.)

We’re now into the fourth generation of Chromebooks, and there are a lot 
of models to choose from. Just about every major computer manufacturer 
has jumped on the Chromebook bandwagon, including Acer, ASUS, Dell, HP, 
Lenovo, and Toshiba. In all, there are almost two dozen different models to 
choose from.
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Dell Chromebook 11

The following table details some of the most popular fourth-generation 
Chromebooks available   today.

Comparing Chromebook Models  

Manufacturer/Model Screen
Memory/Solid 
State Storage Processor

Battery 
Life Price

Acer Chromebook 11 

CB3-111-C8UB 

11.6" (1366×768) 2GB/16GB Intel Celeron Dual-Core 

2.16GHz

8.5 hours    $199.99

Acer Chromebook 13 

CB5-311-T9Y2

13.3" (1366×768) 4GB/16GB NVIDIA Tegra K1 Quad-

Core 2.10GHz

13 hours    $269.99

Acer Chromebook 13 

CB5-311-T1UU

13.3" (1920×1080) 4GB/32GB NVIDIA Tegra K1 Quad-

Core 2.10GHz

11 hours    $379.99

Acer Chromebook 15 15.6" (1366×768) 2GB/16GB Intel Celeron Bay Trail-M 

Dual-Core 1.6GHz

9 hours    $249.99

Acer Chromebook 15 

CB5-571-C09S

15.6" (1920×1280) 4GB/32GB Intel Celeron Bay Trail-M 

Dual-Core 1.6GHz

9 hours    $349.99

Acer Chromebook 15 

C910

15.6" (1920×1280) 4GB/32GB Intel Core i5 Dual-Core 

2.2GHz

8 hours    $499.99

ASUS Chromebook C200 11.6" (1366×768) 2GB/16GB Intel Celeron Bay Trail-M 

Dual-Core 2.16GHz

11 hours    $199.99

ASUS Chromebook C300 13.3" (1366×768) 2GB/16GB Intel Celeron Bay Trail-M 

Dual-Core 2.16GHz

10 hours    $199.00

Dell Chromebook 11 11.6" (1366×768) 4GB/16GB Intel Celeron Dual-Core 

1.4GHz

10 hours    $256.00

Dell Chromebook 11 11.6" (1366×768) 4GB/16GB Intel Core i3 Dual-Core 

1.7GHz

10 hours    $379.00

Google Pixel 2  12.85" (2560×1700) 

touchscreen

8GB/32GB Intel Core i3 Dual-Core 

2.2GHz

12 hours    $999.00
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Manufacturer/Model Screen
Memory/Solid 
State Storage Processor

Battery 
Life Price

Google Pixel 2 12.85" (2560×1700) 

touchscreen

16GB/64GB Intel Core i5 Dual-Core 

2.4GHz

12 hours $1,299.00

Haier Chromebook 11 

(Amazon exclusive)  

11.6" (1366×768) 2GB/16GB Rockchip A17 Quad-Core 

1.8GHz

10 hours $149.00

Hisense Chromebook 

(Walmart exclusive)  

11.6" (1366×768) 2GB/16GB Rockchip A17 Quad-Core 

1.8GHz

10 hours $149.00

HP Chromebook 11 11.6" (1366×768) 2GB/16GB Intel Celeron Bay Trail-M 

Dual-Core 2.16GHz

8 hours $279.99

HP Chromebook 14 14" (1366×768) 2GB/16GB NVIDIA Tegra K1 Quad-

Core 2.10GHz

8 hours $299.99

Lenovo N20p (hybrid 

Chromebook/tablet)  

11.6" (1366×768) 2GB/16GB Intel Celeron Dual-Core 

1.83GHz

8 hours $329.00

Lenovo ThinkPad 11e 11.6" (1366×768) 4GB/16GB Intel Celeron Dual-Core 

1.83GHz

8 hours $349.00

Samsung Chromebook 

XE303C12 

11.6" (1366×768) 2GB/16GB Samsung Exynos 5 Dual-

Core 1.7GHz

7 hours $249.99

Samsung Chromebook 2 

XE500C12

11.6" (1366×768) 2GB/16GB Intel Celeron Bay Trail-M 

Dual-Core 2.16Hz

9 hours $249.99

Samsung Chromebook 2 

XE503C12

11.6" (1366×768) 4GB/16GB Samsung Exynos 5 Quad-

Core 1.9GHz

8 hours $299.99

Samsung Chromebook 2 

XE503C32

13.3" (1920×1280) 4GB/16GB Samsung Exynos 5 Quad-

Core 2.0GHz

8.5 hours $399.99

Toshiba Chromebook 

2 CB30 

13.3" (1366×768) 2GB/16GB Intel Celeron Bay Trail-M 

Dual-Core 2.16GHz

11.5 hours $249.99

Toshiba Chromebook 2 

CB30 (Full HD)

13.3" (1920×1080) 4GB/16GB Intel Celeron Bay Trail-M 

Dual-Core 2.16GHz

9 hours $299.99

As   you can see, most of these models fall into a few general types. Some 
models have 11.6" screens; some have slightly larger 13.3" screens; and a 
few (note Acer’s new Chromebook 15 models) have more traditional 15.6" 
screens. Most screens (regardless of size) have 1366×768 pixel resolution, 
while a few are “true HD” with 1920×1080 (or 1920×1280) resolution. Some 
Chromebooks have 2GB of memory onboard, some have 4GB, and the 
Google Pixel 2 Chromebook offers up to 16GB. Most offer 16GB of solid state 
storage, whereas some higher priced models offer 32GB.

And there are a range of processors available, from Intel, NVIDIA, Rockchip, 
and Samsung.
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When it comes to choosing one model over another, look at the specs, of 
course, as well as the price. (And remember that actual selling price is often 
lower than the suggested retail prices listed here.) But it also helps to look at 
the fit and feel of each model; some units have better keyboards than others, 
some have touchscreens, some feel more robust than others, and so forth. 
Choose a model that fits what you want at the price you want to   pay.

>>>Go Further
GOOGLE PIXEL 2
One model   (in two variations) stands out from the other consumer-oriented 
Chromebooks: Google’s own Chromebook Pixel 2, a state-of-the-art ultrabook 
computer that happens to run the Chrome operating system.

What makes the Pixel 2 different from other Chromebooks is the hardware. 
Instead of a  standard Chiclet keyboard, it features a pretty cool backlit 
keyboard that lights up for nighttime computing. The touchpad  is made from 
etched glass for smooth control and enhanced accuracy. The Pixel 2 also  
features an ultra-high resolution 3:2 aspect ratio 12.85" touchscreen display, 
a  speedy 2.2GHz or 2.4GHz dual-core Intel i3 or i5 processor, 8GB or 16GB 
of RAM, and 32GB or 64GB of solid state storage.   And the Pixel 2 is the first 
Chromebook to feature the new  USB-C ports (two of them, actually), the new 
standard for mobile device connectivity that transmit ten times the power of 
older USB ports.
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Another way the  Pixel 2 stands out from the rest of the pack is its price. The 
base model sells for $999, whereas the step-up model sells for $1,299. This 
puts the Pixel 2 more in competition with Apple’s MacBook Air than other 
Chromebooks, but it may have appeal among elite users. I tend to consider 
it more of a proof of concept than a viable consumer PC, but it’s there if you 
want   it.
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